CHAPTER8

Resource Library

Using the Resource Library

On this tab you find an assortment of resources to help you learn more about Cisco Unified
Communications.

System Release Documentation
Solution Reference Network Design
Tested Deployment and Site Models
Network Topology Diagrams
Component Resources

System Demo

System Compatibility Tool

Ordering Guides

End-of-Sale and End-of-Life Products
Cisco Unified Workspace Licensing

Documentation Wiki

System Release Documentation

System Description

System Release Notes

System Installation and Upgrade Manual
System Test Results

System Description

System Description for Cisco Unified Communications System, Release 7.0(1)
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System Release Notes

e [P Telephony for Enterprise and Midmarket

- System Release Notes for IP Telephony for Enterprise and Midmarket: Cisco Unified
Communications System, Release 7.0(1)

e [P Telephony for Small and Medium Business

— System Release Notes for IP Telephony for Small and Medium Business: Cisco Unified
Communications System, Release 7.0(1)

e Contact Center

— System Release Notes for IP Telephony for Contact Center: Cisco Unified Communications
System, Release 7.0(1)

System Installation and Upgrade Manual

e [P Telephony for Enterprise and Midmarket

— System Installation and Upgrade Manual for IP Telephony for Enterprise and Midmarket: Cisco
Unified Communications System, Release 7.0(1)

e [P Telephony for Small and Medium Business

— System Installation and Upgrade Manual for IP Telephony for Small and Medium Business:
Cisco Unified Communications System, Release 7.0(1)

e Contact Center

- System Installation and Upgrade Manual for IP Telephony for Contact Center: Cisco Unified
Communications System, Release 7.0(1)

System Test Results

e [P Telephony for Enterprise and Midmarket

— System Test Results Manual for IP Telephony for Enterprise and Midmarket: Cisco Unified
Communications System, Release 7.0(1)

e [P Telephony for Small and Medium Business

- System Test Results Manual for IP Telephony for Small and Medium Business: Cisco Unified
Communications System, Release 7.0(1)

e Contact Center

— System Test Results for Contact Center: Cisco Unified Communications System, Release 7.0(1)

Test Results Information

Testing Objectives will give information on the intent of system testing
The test results contain the following information:

e Title—Title of the test.

e ID—Identifier for the test.

e Description—Description of the purpose of the test.
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Solution Reference Network Design

e Features Tested—Component feature tested.

e Status—Result of the test and any defects related to the test case. Possible values are:

Testing Objectives

— Passed—Test case passed as described in the table.
— Failed—Test case failed and the reason is described in the listed defect.

— Passed with exception—Test case as described passed but an anomaly occurred that was not
directly related to the functionality being tested. Possible anomalies are as follows:

The test steps were modified based on the actual feature implementation.
The test setup was modified based on the actual feature implementation.

The test results did not exactly match what was expected although the feature performed as
required.

Defects—Identifier for any defect that was opened against the test. If you have an account with
Cisco.com, you can use the Bug Toolkit to view information about defects.

To access the Bug Toolkit, go to this URL:
— http://tools.cisco.com/Support/BugToolKit/

Cisco Systems validates Cisco Unified Communications systems by designing, installing, configuring,
and testing hardware and software to achieve a predictable, effective, and reliable system. The intent of
system testing is to validate the seamless interoperability and stability of the components that make up
a complete and optimized Cisco Unified Communications system.

Testing performed for Cisco Unified Communications includes (but is not limited to) the following:

Installation, Upgrade, and Usability Testing—To verify software installation and upgrades at the
system level and usability for system components

End-to-End Functionality Testing—To verify the end-to-end functionality of system components
Basic Functionality and Feature Testing—To verify basic call flows and component features

Customer Assurance Program (CAP) Scenario Testing—To re-create and test CAP scenarios
based on TAC input

Interoperability Testing—To verify the interoperability among system components
Scalability Testing—To verify system functionality during scalability tests

Performance, Load, and Stress Testing—To verify system functionality during performance, load,
and stress tests

Failover, Recovery, and Redundancy Testing—To verify system behavior during failover and
recovery, and behavior in redundant configurations

Solution Reference Network Design

Solution Reference Network Design (SRND) guides provide considerations and guidelines for
deploying components for the Cisco Unified Communications System. SRND resources are available at
http://www.cisco.com/go/srnd.
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Tested Deployment and Site Models

Cisco Unified Communications Systems Release 7.0(1) testing was designed to test the hardware and
software components that work together in a multisite distributed deployment. For this testing, several
site models were created. Each site model was designed to test a specific set of features and interactions.
For information about the components, configurations, and environment tested in this Cisco Unified
Communications Release, see Table 8-1.

Table 8-1 Tested Deployment and Site Models

Deployment Model Description

Single-Site Model This model is designed for autonomous offices in which most or all
employees are IPC users. This model can support up to 30,000 users.

Multisite Centralized Call Processing Model This model is designed for distributed operations with a large central
or headquarters site and multiple remote or branch sites. This model
can support up to a total of 30,000 phones distributed among up to a
maximum of 1000 sites. Based upon the bandwidth available, each
site can support any number of users up to the overall total of 30,000
phones.

Multisite Distributed Call Processing Model This model is designed for organizations with large user populations
or large numbers of geographically distributed sites resulting in the
need for more than a single call processing entity. This model is
suited for deployments that require multiple Cisco Unified
Communications Manager clusters or Cisco Unified
Communications Manager Express platforms. Each call processing
entity in this model is configured as a Single-Site Model or Multisite
Centralized Call Processing Model and each has a common dial plan
and feature set.

Clustering Over IP WAN Call Processing Model This model is designed for organizations with large user populations
across multiple sites that are connected by an IP WAN with the QoS
features enabled. It supports the Local Failover Deployment Model
and the Remote Failover Deployment Model.

Network Topology Diagrams

This topic provides topology resources that you can use to document network plans.
e For IP Telephony for Enterprise and Midmarket
— Network Topology Diagrams for IP Telephony for Enterprise and Midmarket
e For IP Telephony for Small and Medium Business
- Network Topology Diagrams for IP Telephony for Small and Medium Business
e For Contact Center
— Network Topology Diagrams for Contact Center

You can download zip files containing Visio drawings of the logical and physical topologies.
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Note You need Microsoft Visio 2003 to open the files. For more information, see How to Use Microsoft Visio

Drawings Efficiently.

If you need to create new Visio drawings, you can use the Cisco Visio stencils located at the Visio

Stencils resource page.

Network Topology Diagrams for IP Telephony for Enterprise and Midmarket

Table 8-2 Network Topology Diagrams for IP Telephony for Enterprise and Midmarket

Description

Filename

Zip file includes the site model topology drawings
listed below.

IPT_ENT_UC701_site_models.zip (5.3) MB

Note If you click the link rather than right-click, the zip file may
open in the secondary window but also replace the contents
of this window. Use your Back button to return to this
window.

All test sites in North America Multisite Distributed
deployment

SiteModel_NorthAmerica_All.vsd

Very Large Campus Clustering over the WAN
(SJC-RFD) site model

SiteModel_LargeCampus_SJCRFD.vsd

Multi-Site Centralized, Clustering over the WAN
with Unified SRST (SFO-ORD) site model

SiteModel_MultiCentralized_SFOORD.vsd

Large SIP Site (DFW) site model

SiteModel_LargeSIP_DFW.vsd

Medium Business with Remote Locations (AZO)
site model

SiteModel_MediumBusiness_AZO.vsd

Small Campus Unified Communications Manager
Site (RXB) site model

SiteModel_SmallUnifiedCM_RXB.vsd

Small Campus SIP Unified Communications
Manager Express Site (ATL) site model

SiteModel_SmallSTIPCME_ATL.vsd

Small Campus H.323 Unified Communications
Manager Express Site (YYZ) site model

SiteModel _SmallH323CME_YYZ.vsd

Cisco CallManager Release 4.2(3) Interoperability
Site (NYC) site model

SiteModel_CallManager42Interop_NYC.vsd

Cisco Unified CallManager Release 5.1(1)
Interoperability Site (RDU) site model

SiteModel_CallManager5 1 Interop_RDU.vsd

All test sites in Europe and Emerging Markets (EUEM)
Multisite Distributed deployment

SiteModel EUEM_All.vsd

EUEM Cisco Unified CallManager
Interoperability Site (LGW) site model

SiteModel_EUEM_UnifiedCMInterop_LGW.vsd

EUEM Medium Site (GVA) site model

SiteModel EUEM_MediumSite_ GVA.vsd

EUEM Large Multisite Centralized with Unified
SRST (CDGQG) site model

SiteModel_EUEM_MultiCentral_CDG.vsd

EUEM Small Campus Multisite H.323 (WAW) site
model

SiteModel EUEM_MultiH323_WAW.vsd
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Table 8-2 Network Topology Diagrams for IP Telephony for Enterprise and Midmarket (continued)
Description Filename
EUEM Non-Cisco Unified CallManager SiteModel EUEM_SIPSite. RKV.vsd
Interoperability Site (RKV) Site model
EUEM Small Site (MAD) site model SiteModel EUEM_SmallSite. MAD.vsd
MediumBusiness Manchester (MAN) site model SiteModel_MediumBusiness_ MAN.vsd

Zip file includes component topology drawings listed |IPT_ENT_UC701_topology_diagrams.zip (2.55) MB

below. Note If you click the link rather than right-click, the zip file may

open in the secondary window but also replace the contents
of this window. Use your Back button to return to this

window.
Cisco Unified MeetingPlace Topology in Multisite MeetingPlace_Topology.vsd
Distributed Deployment
QSIG connections to Cisco Unified QSIG_UnifiedCM_Clusters.vsd
Communications Manager clusters
QSIG connections to Cisco Unified QSIG_UnifiedCMExpress.vsd
Communications Manager Express sites
Cisco Unity logical topology GB_IPTNA_Load_Diagrams.vsd (tab: Unity DFW)
Cisco Unity and Unity Connection physical GB_IPTNA_Load_Diagrams.vsd (tab: Unity SJC-RFD)
topology - North America
Cisco Unity setup in NA test environment GB_IPTNA_Load_Diagrams.vsd (tab: RDU)
Cisco Unified CallManager Express integrated GB_IPTNA_Load_Diagrams.vsd (tab: ATL-YYZ)

with Cisco IP-to-IP Gateways

Network Topology Diagrams for IP Telephony for Small and Medium Business

Table 8-3 Network Topology Diagrams IP Telephony for Small and Medium Business

Description Filename

Zip file includes the site model topology drawings IPT_SMB_UC701_topology_diagrams.zip (1.83 MB)

listed below. Note If you click the link rather than right-click, the zip file may

open in the secondary window but also replace the contents
of this window. Use your Back button to return to this

window.
SBCS Single Site Model single-site-UC500.vsd
Cisco Unified Communication 500 Series UC500-fax.vsd
configured for T.37 Fax
Inter-Cluster Calls Between Two UC 500 Systems UC500-scenario.vsd
Through IP-IP Gateway (Convington-Freddo and
Robins-Freddo)
Cisco Communications Manager Express Single single-site-CMECUE.vsd

Site Model
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Table 8-3 Network Topology Diagrams IP Telephony for Small and Medium Business (continued)
Description Filename
Cisco Communications Manager Express Multisite multisite-CMECUE.vsd

Distributed Call Processing Model

[P-to-IP Gateway Deployment and Cisco IPIPGW-deploy.vsd
Communications Manager Express Sites

Network Topology Diagrams for Contact Center

Table 8-4 Network Topology Diagrams for Contact Center

Description Filename

Zip file includes logical and physical drawings in Test |CC_UC701_topology_diagrams]1.zip (right-click to download zip)
Bed 1 as listed below. 6.8 MB

Note If you click the link rather than right-click, the zip file may
open in the secondary window but also replace the contents
of this window. Use your Back button to return to this

window.

Unified IP IVR Sites in Test Bed 1

UC701 UCCE IP IVR Logical All.vsd

Site 1 IP IVR Logical Topology

UC701 UCCE IP IVR Logical Sitel.vsd

Site 2 IP IVR Logical Topology

UC701 UCCE IP IVR Logical Site2.vsd

Site 3 IP IVR Logical Topology

UC701 UCCE IP IVR Logical Site3.vsd

Site 4 IP IVR Logical Topology

UC701 UCCE IP IVR Logical Site4.vsd

Site 5 IP IVR Logical Topology

UC701 UCCE IP IVR Logical Site5.vsd

Site 6 IP IVR Logical Topology

UC701 UCCE IP IVR Logical Site6.vsd

Site 7 IP IVR Logical Topology

UC701 UCCE IP IVR Logical Site7.vsd

Site 8 IP IVR Logical Topology

UC701 UCCE IP IVR Logical Site8.vsd

Site 1 IP IVR Physical Topology

UC701 UCCE IP IVR Physical Sitel.vsd

Site 2 IP IVR Physical Topology

UC701 UCCE IP IVR Physical Site2.vsd

Site 3 IP IVR Physical Topology

UC701 UCCE IP IVR Physical Site3.vsd

Site 4 IP IVR Physical Topology

UC701 UCCE IP IVR Physical Site4.vsd

Site 5 IP IVR Physical Topology

UC701 UCCE IP IVR Physical Site5.vsd

Site 6 IP IVR Physical Topology

UC701 UCCE IP IVR Physical Site6.vsd

Site 7 IP IVR Physical Topology

UC701 UCCE IP IVR Physical Site7.vsd

Site 8 IP IVR Physical Topology

UC701 UCCE IP IVR Physical Site8.vsd

Zip file includes logical and physical drawings in Test |CC_UC701_topology_diagrams3.zip (right-click to download zip)
Bed 2 as listed below. 4.9 MB

Note If you click the link rather than right-click, the zip file may
open in the secondary window but also replace the contents
of this window. Use your Back button to return to this
window.

Parent and Child Sites in Test Bed 2 UC701 UICM PC Logical All.vsd

Cisco Unified Communications System for IP Telephony for Small and Medium Business Release 7.0(1) g
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Table 8-4 Network Topology Diagrams for Contact Center (continued)

Description

Filename

Site 1 Parent and Child Logical Topology

UC701 UICM PC Logical Sitel.vsd

Site 4 Parent and Child Logical Topology

UC701 UICM PC Logical Site4.vsd

Site 5 Parent and Child Logical Topology

UC701 UICM PC Logical Site5.vsd

Site 8 Parent and Child Logical Topology

UC701 UICM PC Logical Site8.vsd

Site 9 Parent and Child Logical Topology

UC701 UICM PC Logical Site9.vsd

Site 1 Parent and Child Physical Topology

UC701 UICM PC Physical Sitel.vsd

Site 4 Parent and Child Physical Topology

UC701 UICM PC Physical Site4.vsd

Site 5 Parent and Child Physical Topology

UC701 UICM PC Physical Site5.vsd

Site 8 Parent and Child Physical Topology

UC701 UICM PC Physical Site8.vsd

Site 9 Parent and Child Physical Topology

UC701 UICM PC Physical Site8.vsd

Zip file includes logical and physical drawings in Test
Bed 3 as listed below.

CC_UC701_topology_diagrams2.zip (right-click to download zip)
9 MB

Note

If you click the link rather than right-click, the zip file may
open in the secondary window but also replace the contents
of this window. Use your Back button to return to this

window.

Unified CVP Sites in Test Bed 3

UC701 UCCE CVP Logical All.vsd

Site 1 CVP Logical Topology

UC701 UCCE CVP Logical Sitel.vsd

Site 2 CVP Logical Topology

UC701 UCCE CVP Logical Site2.vsd

Site 3 CVP Logical Topology

UC701 UCCE CVP Logical Site3.vsd

Site 5 CVP Logical Topology

UC701 UCCE CVP Logical Site5.vsd

Site 6 CVP Logical Topology

UC701 UCCE CVP Logical Site6.vsd

Site 7 CVP Logical Topology

UC701 UCCE CVP Logical Site7.vsd

Site 8 CVP Logical Topology

UC701 UCCE CVP Logical Site8.vsd

Site 1a CVP Physical Topology

UC701 UCCE CVP Physical Sitela.vsd

Site 1b CVP Physical Topology

UC701 UCCE CVP Physical Sitelb.vsd

Site 1¢ CVP Physical Topology

UC701 UCCE CVP Physical Sitelc.vsd

Site 2 CVP Physical Topology

UC701 UCCE CVP Physical Site2.vsd

Site 3 CVP Physical Topology

UC701 UCCE CVP Physical Site3.vsd

Site 5a CVP Physical Topology

UC701 UCCE CVP Physical Site5a.vsd

Site Sb CVP Physical Topology

UC701 UCCE CVP Physical SiteSb.vsd

Site 6 CVP Physical Topology

UC701 UCCE CVP Physical Site6.vsd

Site 7 CVP Physical Topology

UC701 UCCE CVP Physical Site7.vsd

Site 8 CVP Physical Topology

UC701 UCCE CVP Physical Site8.vsd
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How to Use Microsoft Visio Drawings Efficiently

Microsoft Visio allows you to bring drawings into several applications (for example, Microsoft Word,
Powerpoint). Unfortunately, the default method is to insert the whole “Visio object” into a file. This can
cause problems.

When you copy and paste a Visio drawing into another application, the Visio object includes all the
application data with the drawing. This object information is needed if you want to be able to
double-click the drawing from Word or Powerpoint and have it open up in Visio for editing. But pasting
as an object adds many megabytes to the size of your file. With only a few such drawings, a Word
document can bloat from 300 KB to 12 MB, making it troublesome to share among authors or reviewers,
and a trial for partners or customers to download. (They might even give up before it is done.) In
addition, very large documents are more problem-prone.

Bringing a Visio Drawing into a Document

Step 1
Step 2

Step 3

Unless you really need the live editing capability, avoid unnecessary file bloat by performing an extra
step when you paste:

In Visio, copy the drawing as you normally do. Tip: Ctrl-C copies the whole drawing.

At the desired location in the destination document, choose Edit > Paste Special. In the Paste Special
dialog box, choose Picture (Windows Metafile).

Paste Special @@

Source:  Wisho 2000 Draving

Ci\Documents and SettingsifweisertiMy D...

(%) Paste:
() Paste fink:

Inserts the contents of the Clipboard as & windows

IE metafile pichure.,

Click OK. The drawing pastes as an ordinary picture. If it is not positioned properly, choose Format >
Picture, click the Layout tab and select In line with text. This is generally the most reliable layout
option.

The Bottom Line
Do not use the paste default (Edit > Paste or Ctrl-V) to paste Visio drawings. Always use Paste Special.

Cisco Unified Communications System for IP Telephony for Small and Medium Business Release 7.0(1) g



Chapter8 Resource Library |

Bl Component Resources

Downsizing Existing Drawings

If a document is larger than it should be, you can check to see if the Visio drawings are the reason and,
if so, fix the problem.

Step1  With the drawing selected in the Word or Powerpoint document, choose Edit. At the bottom of the Edit
menu, you will see one of the following:

e Edit Object, if the drawing was inserted by simple pasting. It is a Visio object and taking up much
more file space than it needs to. Go on to step 2.

e Edit Picture, if the drawing was inserted properly, as a picture. It is not the source of the large file
size.

Step2  If the drawing is an object, cut it (Ctrl-X), then repaste it as in Bringing a Visio Drawing into a
Document.

Tip You can easily click through the document to check each picture by using Word's handy Go To feature:
Where you want to start searching, press Ctrl-G. In the Go to what list, select Graphic and click Next.
You go to the next graphic. Click it to select, and then check as in step 1. If needed, repaste as in step 2.
Click Next and continue these steps for other graphics.

Component Resources

Component Resources Documentation

Configuration Command Files

Component Resources Documentation

¢ Component Resources Documentation for IP Telephony for Enterprise and Midmarket
e Component Resources Documentation for IP Telephony for Small and Medium Business

e Component Resources Documentation for Contact Center

Component Resources Documentation for IP Telephony for Enterprise and Midmarket

Table 8-5 provides links to the main page for documentation on various Cisco Unified Communications
components, from which you can navigate to individual documents. For documentation on specific tasks,
see Component Installation and Configuration on the Implement tab. For documentation on all other
Cisco products, go to http://www.cisco.com/web/psa/products/index.html.
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Table 8-5

Component Resources

Component Resources Documentation for IP Telephony for Enterprise and Midmarket

Category

Component

Documentation URL

Call Control

Cisco Unified Communications Manager

http://www.cisco.com/en/US/products/sw/voicesw
/ps556/tsd_products_support_series_home.html

Cisco Unified Communications Manager
Business Edition

http://www.cisco.com/en/US/products/ps7273/tsd_
products_support_series_home.html

Cisco Unified Communications Manager
Express

http://www.cisco.com/en/US/products/sw/voicesw
/ps4625/tsd_products_support_series_home.html

Cisco Unified Survivable Remote Site
Telephony (SRST)

http://www.cisco.com/en/US/products/sw/voicesw
/ps2169/tsd_products_support_series_home.html

Cisco Unified Presence

http://www.cisco.com/en/US/products/ps6837/tsd_
products_support_series_home.html

Cisco Unified Business Attendant
Console and Unified Department
Attendant Console

http://www.cisco.com/en/US/partner/products/ps7
282/tsd_products_support_series_home.html

Cisco Unified Communications 500
Series for Small Business

http://www.cisco.com/en/US/products/ps7293/tsd_
products_support_series_home.html

Contact Center

Cisco Customer Response Solutions
(Cisco Unified Contact Center Express)

http://www.cisco.com/en/US/products/sw/custcos
w/ps1846/tsd_products_support_series_home.html

Applications Cisco Emergency Responder http://www.cisco.com/en/US/products/sw/voicesw
/ps842/tsd_products_support_series_home.html
Cisco Fax Server http://www.cisco.com/en/US/products/ps6178/tsd_
products_support_series_home.html
Cisco Unified Application Environment |http://www.cisco.com/en/US/products/ps7058/tsd_
products_support_series_home.html
Cisco Unified PhoneProxy http://www.cisco.com/en/US/products/ps7057/tsd_
products_support_series_home.html
Conferencing Cisco Unified MeetingPlace http://www.cisco.com/en/US/products/sw/ps5664/

ps5669/tsd_products_support_series_home.html

Cisco Unified MeetingPlace Express

http://www.cisco.com/en/US/products/ps6533/tsd_
products_support_series_home.html

Cisco Unified Videoconferencing

http://www.cisco.com/en/US/products/hw/video/p
s1870/tsd_products_support_series_home.html

Voice Mail and Unified
Messaging

Cisco Unity

http://www.cisco.com/en/US/products/sw/voicesw
/ps2237/tsd_products_support_series_home.html

Cisco Unity Connection

http://www.cisco.com/en/US/products/ps6509/tsd_
products_support_series_home.html

Cisco Unity Express

http://www.cisco.com/en/US/products/sw/voicesw
/ps5520/tsd_products_support_series_home.html

Cisco Unified Messaging Gateway

http://www.cisco.com/en/US/partner/products/ps8
605/tsd_products_support_series_home.html
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Table 8-5

Component Resources Documentation for IP Telephony for Enterprise and Midmarket (continued)

Category

Component

Documentation URL

Endpoints and Clients

Cisco Unified IP Phone 7900 Series

http://www.cisco.com/en/US/products/hw/phones/
ps379/tsd_products_support_series_home.html

Cisco IP Communicator

http://www.cisco.com/en/US/products/sw/voicesw
/ps5475/tsd_products_support_series_home.html

Cisco Unified Personal Communicator

http://www.cisco.com/en/US/products/ps6844/tsd
products_support_series_home.html

Cisco Unified Video Advantage

http://www.cisco.com/en/US/products/sw/voicesw
/ps5662/tsd_products_support_series_home.html

Wireless and Mobility

Cisco Aironet 1200 Series Access Points

http://www.cisco.com/en/US/products/hw/wireless
/ps430/tsd_products_support_series_home.html

Cisco Unified Mobility Advantage

http://www.cisco.com/en/US/products/ps7270/tsd_
products_support_series_home.html

Cisco Unified Mobile Communicator

http://www.cisco.com/en/US/products/ps7271/tsd_
products_support_series_home.html

Security

Cisco ASA 5500 Series Adaptive
Security Appliances

http://www.cisco.com/en/US/products/ps6120/tsd_
products_support_series_home.html

Cisco Catalyst 6500 Series Firewall
Services Module (FWSM)

http://www.cisco.com/en/US/products/hw/module
s/ps2706/ps4452/tsd_products_support_model_ho
me.html

Cisco Catalyst 6500 Series Intrusion
Detection System (IDSM-2) Module

http://www.cisco.com/en/US/products/hw/module
s/ps2706/ps5058/tsd_products_support_model_ho
me.html

Cisco Intrusion Prevention System
Appliance IPS-4200

http://www.cisco.com/en/US/products/sw/secursw
/ps2113/tsd_products_support_series_home.html

Cisco NAC Appliance (Clean Access)

http://www.cisco.com/en/US/products/ps6128/tsd_
products_support_series_home.html

Management Center for Cisco Security
Agents

http://www.cisco.com/en/US/products/sw/secursw
/ps5057/products_installation_and_configuration_
guides_list.html

Cisco Security Agents

http://www.cisco.com/en/US/products/sw/secursw
/ps5057/tsd_products_support_series_home.html

Network Management

Cisco Unified Operations Manager

http://www.cisco.com/en/US/products/ps6535/tsd_
products_support_series_home.html

Cisco Unified Service Monitor

http://www.cisco.com/en/US/products/ps6536/tsd_
products_support_series_home.html

Cisco netManager - Unified
Communications

http://www.cisco.com/en/US/products/ps7243/tsd_
products_support_series_home.html

Cisco Unified Service Statistics Manager

http://www.cisco.com/en/US/products/ps7285/tsd_
products_support_series_home.html
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Table 8-5 Component Resources Documentation for IP Telephony for Enterprise and Midmarket (continued)
Category Component Documentation URL

Communications Cisco IOS Software Release 12.4 T http://www.cisco.com/en/US/products/ps6441/tsd_
Infrastructure products_support_series_home.html

Cisco 1700 Series Modular Access Rout-
ers

http://www.cisco.com/en/US/products/hw/routers/
ps221/tsd_products_support_series_home.html

Cisco 2600 Series Routers

http://www.cisco.com/en/US/products/hw/routers/
ps259/tsd_products_support_series_home.html

Cisco 2800 Series Routers/Voice
Gateways

http://www.cisco.com/en/US/products/ps5854/tsd_
products_support_series_home.html

Cisco 3700 Series Voice
Gateways/Gatekeepers

http://www.cisco.com/en/US/products/hw/routers/
ps282/tsd_products_support_series_home.html

Cisco 3800 Series Routers/Voice
Gateways

http://www.cisco.com/en/US/products/ps5855/tsd_
products_support_series_home.html

Cisco 7200 Series Voice Gateways

http://www.cisco.com/en/US/products/hw/routers/
ps341/tsd_products_support_series_home.html

Cisco Integrated Services Router (ISR)
1861

http://www.cisco.com/en/US/products/ps5853/tsd_
products_support_series_home.html

Cisco Unified Border Element

http://www.cisco.com/en/US/products/sw/voicesw
/ps5640/tsd_products_support_series_home.html

Cisco Catalyst 3550 Series Access
Switches

http://www.cisco.com/en/US/products/hw/switche
s/ps646/tsd_products_support_series_home.html

Cisco Catalyst 3560 Series Access
Switches

http://www.cisco.com/en/US/products/hw/switche
s/ps5528/tsd_products_support_series_home.html

Cisco Catalyst 3750 Series Data Center
Switches

http://www.cisco.com/en/US/products/hw/switche
s/ps5023/tsd_products_support_series_home.html

Cisco Catalyst 4500 Series Access
Switches

http://www.cisco.com/en/US/products/hw/switche
s/ps4324/tsd_products_support_series_home.html

Cisco Catalyst 6500 Series Switches

http://www.cisco.com/en/US/products/hw/switche
s/ps708/tsd_products_support_series_home.html

Cisco Catalyst 6600 Series Voice
Gateways

http://www.cisco.com/en/US/products/hw/switche
s/ps700/tsd_products_support_eol_series_home.ht
ml

Cisco V(G224/248 Analog Voice
Gateways

http://www.cisco.com/en/US/products/hw/gatecon
t/ps2250/tsd_products_support_series_home.html

Cisco ATA 186,188 (analog telephony
adaptor)

http://www.cisco.com/en/US/products/hw/gatecon
t/ps514/tsd_products_support_series_home.html

Component Resources Documentation for IP Telephony for Small and Medium Business

Table 8-6 provides links to the main page for documentation on various Cisco Unified Communications
components, from which you can navigate to individual documents. For documentation on specific tasks,
see Component Installation and Upgrade on the Implement tab. For documentation on all other Cisco
products, go to http://www.cisco.com/web/psa/products/index.html.
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Table 8-6

Component Resources Documentation for IP Telephony for Small and Medium Business

Category

Component

Documentation URL

Call Control

Cisco Unified Communications 500
Series for Small Business

http://www.cisco.com/en/US/products/ps7293/tsd_produ
cts_support_series_home.html

Cisco Unified Communications
Manager Express

http://www.cisco.com/en/US/products/sw/voicesw/ps46
25/tsd_products_support_series_home.html

Contact Center

Cisco Unified Contact Center Express

http://www.cisco.com/en/US/products/sw/custcosw/ps1
846/tsd_products_support_series_home.html

Conferencing

Cisco Unified MeetingPlace Express

http://www.cisco.com/en/US/products/ps6533/tsd_produ
cts_support_series_home.html

Cisco Unified Video Advantage

http://www.cisco.com/en/US/products/sw/voicesw/ps56
62/tsd_products_support_series_home.html

Voice Mail and
Unified Messaging

Cisco Unity Express

http://www.cisco.com/en/US/products/sw/voicesw/ps55
20/tsd_products_support_series_home.html

Endpoints and Clients

Cisco Unified IP Phone 7900 Series

http://www.cisco.com/en/US/products/hw/phones/ps379
/tsd_products_support_series_home.html

Cisco Unified IP Phone 500 series

http://www.cisco.com/en/US/products/ps9730/tsd_produ
cts_support_series_home.html

Cisco IP Communicator

http://www.cisco.com/en/US/products/sw/voicesw/ps54
75/tsd_products_support_series_home.html

Cisco Unified CallConnector MS Win-
dows Client

http://www.cisco.com/en/US/products/ps7274/tsd_produ
cts_support_series_home.html

Network Management |Cisco netManager Unified http://www.cisco.com/en/US/products/ps7243/tsd_produ
Communications cts_support_series_home.html

Communications Cisco IOS Software Releasel12.4(20)T  |http://www.cisco.com/en/US/products/ps6441/tsd_produ

Infrastructure cts_support_series_home.html

Cisco 3800 Integrated Services Router

http://www.cisco.com/en/US/products/ps5855/tsd_produ
cts_support_series_home.html

Cisco 2800 Integrated Services Router

http://www.cisco.com/en/US/products/ps5854/tsd_produ
cts_support_series_home.html

Cisco 870 Integrated Services Router

http://www.cisco.com/en/US/products/hw/routers/ps380
/tsd_products_support_series_home.html

Cisco 1861 Integrated Services Router

http://www.cisco.com/en/US/products/ps5853/tsd_produ
cts_support_series_home.html

Cisco Catalyst 500 series Switch

http://www.cisco.com/en/US/products/ps6545/tsd_produ
cts_support_series_home.html

Cisco Catalyst 3560 series Switch

http://www.cisco.com/en/US/products/hw/switches/ps55
28/prod_release_notes_list.html
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Component Resources Documentation for Contact Center

Table 8-7 provides links to the main page for documentation on various Cisco Unified Communications
components, from which you can navigate to individual documents. For documentation on specific tasks,
see Component Installation and Configuration Guides on the Implement tab. For documentation on all

other Cisco products, go to http://www.cisco.com/web/psa/products/index.html.

Table 8-7

Component Resources Documentation for Contact Center

Category

Component

Documentation URLs

Call Control

Cisco Unified Communications Manager

http://www.cisco.com/en/US/products/sw/voicesw
/ps556/tsd_products_support_series_home.html

Contact Center

Cisco Unified Intelligent Contact
Management Enterprise

http://www.cisco.com/en/US/products/sw/custcos
w/ps1001/tsd_products_support_series_home.html

Cisco Unified Contact Center Enterprise

http://www.cisco.com/en/US/products/sw/custcos
w/ps1844/tsd_products_support_series_home.html

Cisco Support Tools

http://www.cisco.com/en/US/products/ps5905/tsd_
products_support_series_home.html

Cisco Unified Expert Advisor

http://www.cisco.com/en/US/products/ps9675/tsd_
products_support_series_home.html

Cisco Unified IP IVR

http://www.cisco.com/en/US/products/sw/custcos
w/ps1846/tsd_products_support_series_home.html

Cisco Unified Customer Voice Portal

http://www.cisco.com/en/US/products/sw/custcos
w/ps1006/tsd_products_support_series_home.html

Computer Telephony Integration Object
Server (CTI OS) and Agent Desktop

http://www.cisco.com/en/US/products/sw/custcos
w/ps14/tsd_products_support_series_home.html

Cisco Agent Desktop (CAD) Server and
Agent Desktop

http://www.cisco.com/en/US/products/sw/custcos
w/ps427/tsd_products_support_series_home.html

Applications Cisco Unified Presence http://www.cisco.com/en/US/products/ps6837/tsd_
products_support_series_home.html
Conferencing Cisco Unified Conferencing for http://www.cisco.com/en/US/products/ps7266/tsd_

TelePresense

products_support_series_home.html

Cisco Unified Videoconferencing 3500
Series Products

http://www.cisco.com/en/US/products/hw/video/p
s1870/tsd_products_support_series_home.html

Voice Mail and Unified
Messaging

Cisco Unity Connection

http://www.cisco.com/en/US/products/ps6509/tsd_
products_support_series_home.html

End Points and Clients

Cisco IP Communicator

http://www.cisco.com/en/US/products/sw/voicesw
/ps5475/tsd_products_support_series_home.html

Cisco Unified Personal Communicator

http://www.cisco.com/en/US/products/ps6844/tsd_
products_support_series_home.html

Cisco Unified Video Advantage

http://www.cisco.com/en/US/products/sw/voicesw
/ps5662/tsd_products_support_series_home.html

Cisco Unified IP Phones

http://www.cisco.com/en/US/products/hw/phones/
ps379/tsd_products_support_series_home.html

Network Management

Cisco Unified Operations Manager

http://www.cisco.com/en/US/products/ps6535/tsd_
products_support_series_home.html
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Table 8-7 Component Resources Documentation for Contact Center (continued)
Category Component Documentation URLs
Security Cisco Catalyst 6500 Series Switch http://www.cisco.com/en/US/products/hw/module
Firewall Services Module (FWSM) s/ps2706/ps4452/tsd_products_support_model_ho
me.html
Cisco Adaptive Security Appliance http://www.cisco.com/en/US/products/ps6120/tsd_
(ASA) 5540 Services products_support_series_home.html
CiscoWorks Management Center for http://www.cisco.com/en/US/products/sw/cscowor
Cisco Security Agents k/ps5212/tsd_products_support_eol_series_home.
html
Cisco Security Agent for Unified http://www.cisco.com/en/US/products/sw/voicesw
Communications Manager /ps556/tsd_products_support_series_home.html
Cisco Security Agent for Unified IP IVR |http://www.cisco.com/en/US/products/sw/custcos
w/ps1846/tsd_products_support_series_home.html
Cisco Security Agent for Unified http://www.cisco.com/en/US/products/sw/custcos
Intelligent Contact Management w/ps1001/tsd_products_support_series_home.html
Enterprise
Cisco Security Agent for Unified http://www.cisco.com/en/US/products/sw/custcos
Customer Voice Portal w/ps1006/tsd_products_support_series_home.html
Communications Cisco IOS Software Release 12.4 T http://www.cisco.com/en/US/products/ps6441/tsd_
Infrastructure products_support_series_home.html
Cisco 3825, 3845 (Unified CVP VXML, |http://www.cisco.com/en/US/products/ps5855/tsd_
voice/data, H.323, SIP, and MGCP products_support_series_home.html
gateways)
Cisco AS5400XM (Unified CVP VXML |http://www.cisco.com/en/US/products/hw/univgat
voice, H.323, and PSTN gateways) e/ps505/tsd_products_support_series_home.html
RSVP Agent (on 38xx platforms) http://www.cisco.com/en/US/products/hw/routers/
ps282/tsd_products_support_series_home.html
Cisco 7206 VXR (core/WAN router) http://www.cisco.com/en/US/products/hw/routers/
ps341/tsd_products_support_series_home.html
Cisco 881 router http://www.cisco.com/en/US/products/hw/routers/
ps380/tsd_products_support_series_home.html
Cisco Catalyst 3750 (access switch) http://www.cisco.com/en/US/products/hw/switche
s/ps5023/tsd_products_support_series_home.html
Cisco Catalyst 6506, 6509 (core switch, |http://www.cisco.com/en/US/products/hw/switche
Supervisor 2) s/ps708/tsd_products_support_series_home.html
Cisco Catalyst 6506, 6509 (MSFC,
Supervisor 2)
Cisco CSS 11501 Content Services http://www.cisco.com/en/US/products/hw/contnet
Switch w/ps792/tsd_products_support_series_home.html
Cisco Communication Media Module http://www.cisco.com/en/US/products/hw/switche
(CMM) s/ps708/tsd_products_support_series_home.html
Wireless Cisco Aironet Access Point 1240AG http://www.cisco.com/en/US/products/ps6521/tsd_

products_support_series_home.html
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http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_series_home.html
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http://www.cisco.com/en/US/products/ps5855/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/univgate/ps505/tsd_products_support_series_home.html
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http://www.cisco.com/en/US/products/hw/routers/ps380/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/switches/ps5023/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/switches/ps708/tsd_products_support_series_home.html
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Configuration Command Files

Component Resources

e Configuration Command Files for IP Telephony for Enterprise and Midmarket

e Configuration Command Files for IP Telephony for Small and Medium Business

e Configuration Command Files for Contact Center

Configuration Command Files for IP Telephony for Enterprise and Midmarket

Table 8-8 Configuration Command Files for IP Telephony for Enterprise and Midmarket

Description

Filename

Zip file includes Cisco device configurations listed below:

Note = Some parameters, such as passwords, have been removed
from the configuration files for security reasons.

IPT_ENT_UCT701 _reference_configs.zip (right-click to
download zip) includes the files below.

Note If youclick the link rather than right-click, the zip
file may open in the secondary window but also
replace the contents of this window. Use your
Back button to return to this window.

Cisco Unified Communications Manager Express on a Cisco 3845
(ALT-CME-3845-3)

ATL_3845.txt

Cisco Unified Communications Manager Express on a Cisco 2651
(YYZ-CME-3745-1)

YYZ_Config.txt

Cisco Unified Communications Manager Express on a Cisco 3725
with SIP and SCCP configured (Covington-3725-CME)

Covington-SIP-SCCP.txt

Cisco Unified Communications Manager Express on a Cisco 2801
with SIP configured (Ely-2801-CME)

ELY-PureSIP.txt

Cisco Unified Communications Manager Express on a Cisco 2801
with SCCP configured (Robins-2801-GW)

Robins-PureSCCP.txt

Cisco Unity Express on a Cisco 3745 (YYZ-CUE-3745)

ABI-SRST3-CUE

Cisco 3745 primary gatekeeper (SJC-RFD-GK-1)

Gatekeeper_Primary_Config.txt

Cisco 3745 alternate gatekeeper (SJC-RFD-GK-2)

Gatekeeper_Alternate_Config.txt

[P-IP gateway configured for Cisco Unified Communications
Manager to IP-IP gateway SIP trunks (ATL-IPIPGW)

ATL-IPIPGW.txt

Inter-cluster calls from Cisco Unified Communications Manager
Express to Cisco Communications Manager via IP-IP gateway
(Robins-IPIP-GW)

Robins-IPIPGW-config.txt

Cisco 3745 SIP gateway (DFW-3745GW)

SJC-RFD-GK1 and SJC-RFD-GK2

Cisco Aironet WLAN Controller

wlan-controller.txt
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Configuration Command Files for IP Telephony for Small and Medium Business

Table 8-9 Configuration Command Files for Small Business
Description Filename
Zip file includes Cisco device configurations listed below: IPT_SMB_UC701 _reference_configs.zip (50 KB)

Note = Some parameters, such as passwords, have been removed includes the files below.

from the configuration files for security reason. Note If you click the link rather than right-click, the zip
file may open in the secondary window but also
replace the contents of this window. Use your Back
button to return to this window.

Cisco Unified Communications 500 Series uc500-Covington-Freddo.txt
(Convington-Freddo-UC500)

Cisco Unified Communications 500 Series (Robins-Freddo |isr1861-Robins-Freddo.txt

-UC500)
Table 8-10 Configuration Command Files for Medium Business
Definition Filename
Zip file includes Cisco device configurations listed below: IPT_SMB_UC701 _reference_configs.zip (50 KB)

Note  Some parameters, such as passwords, have been removed includes the files below.

from the configuration files for security reasons. Note If you click the link rather than right-click, the zip
file may open in the secondary window but also
replace the contents of this window. Use your
Back button to return to this window.

Cisco Unified Communications Manager Express on a Cisco |ELY-PureSIP.txt
2801 Series Cisco Integrated Router (Ely-2801-CME)

Cisco Unified Communications Manager Express on a Cisco |Otis-2825-CME.txt
3825 Series Cisco Integrated Router (Otis-2825-CME)

Configuration Command Files for Contact Center

Table 8-11 Configuration Command Files for Contact Center

Description Filename

Test Bed 1 Call Flows: Cisco Unified Communications CC_UC701_reference_configs_CCM.zip (right-click to
Manager Post-Routed Call Flow Components download zip) includes the files below.

Note If you click the link rather than right-click, the zip
file may open in the secondary window but also
replace the contents of this window. Use your Back
button to return to this window.

Sitel Cisco 3750 Switchl cs1-3750-sw1l.txt
Sitel Cisco 3845 Conference/Transcoder Bridgel cs1-3845-ctl.txt
Sitel Cisco 6509 Switchl cs1-6509-sw1.txt
Sitel Cisco 7206 VXR Router cs1-7206.txt
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Table 8-11 Configuration Command Files for Contact Center (continued)

Description Filename

Sitel Cisco CMM Gateway1l

csl-cmm-gwl.txt

Sitel Cisco CMM Gateway?2

csl-cmm-gw2.txt

Site2 Cisco 3750 Switchl

¢s2-3750-swl.txt

Site2 Cisco 7206 VXR Router

cs2-7206.txt

Site2 Cisco 3845 Conference/Transcoder Bridge2

cs2-3845-ct].txt

Site3 Cisco 3750 Switchl

¢s3-3750-swl.txt

Site3 Cisco 7206 VXR Router

¢s3-7206.txt

Site3 Cisco 3845 Conference/Transcoder Bridge3

cs3-3845-ct].txt

Site4 Cisco 3750 Switchl

cs4-3750-swl.txt

Site4 Cisco 3745 Gatekeeper3

cs4-3745-gk3.txt

Site4 Cisco AS5400HPX Gatewayl

cs4-5400-gw1.txt

Site4 Cisco AS5400HPX Gateway2

cs4-5400-gw2.txt

Site4 Cisco AS5400HPX Gateway3

cs4-5400-gw3.txt

Site4 Cisco 7206 VXR Router

cs4-7206.txt

Site4 Cisco 6509 Switchl

¢cs4-6509-sw1.txt

Site5 Cisco 3750 Switchl

¢s5-3750-swl.txt

Site5 Cisco 7206 VXR Router

¢s5-7206.txt

Site5 Cisco CMM Gateway

cs5-cmm-gwl.txt

Site5 Cisco 3845 Conference/Transcoder Bridge5

cs5-3845-ctl.txt

Site5 Cisco 6506 Switchl

¢cs5-6506-swl.txt

Site6 Cisco 3750 Switchl

¢cs6-3750-swl.txt

Site6 Cisco 3745 Gateway1

cs6-3745-gwl.txt

Site6 Cisco 3745 Gateway?2

cs6-3745-gw2.txt

Site6 Cisco 7206 VXR Router

¢s6-7206.txt

Site6 Cisco 3845 Conference/Transcoder Bridge6

¢cs6-3845-ct].txt

Site8 Cisco 3750 Switchl

¢cs8-3750-sw2.txt

Site8 Cisco 3825 Gatekeeperl

cs8-3825-gkl.txt

Site8 Cisco 3825 Gatewayl

cs8-3825-gwl.txt

Site8 Cisco 3825 Gateway?2

cs8-3825-gw2.txt

Site8 Cisco 3825 Gateway3

cs8-3825-gw3.txt

Site8 Cisco 3845 Conference/Transcoder Bridgel

cs8-3845-ctl.txt

Site8 Cisco 7206 VXR Router

¢s8-7206.txt
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Table 8-11 Configuration Command Files for Contact Center (continued)

Description

Filename

Test Bed 2 Call Flows: Parent and Child Call Flows

CC_UC701_reference_configs_PC.zip (right-click to
download zip) includes the files below.

Note If you click the link rather than right-click, the zip
file may open in the secondary window but also
replace the contents of this window. Use your Back
button to return to this window.

Sitel Cisco 3750 Switchl

pesl-swl.txt

Sitel Cisco 3845 Gateway1

pcs1-3845-gwl.txt

Sitel Cisco 6509 Switch

pcs1-6509-swl.txt

Sitel Cisco 7206 VXR Router

pcs1-7206.txt

Site4 Cisco 3750 Switchl

pcs4-swl.txt

Site4 Cisco 3745 Gatekeeperl

pcs4-3745-gkl.txt

Site4 Cisco 3745 Gatekeeper2

pcs4-3745-gk2.txt

Site4 Cisco 3845 Gatewayl

pcs4-3845-gwl.txt

Site4 Cisco 7206 VXR Router

pcs4-7206.txt

Site4 Cisco 6509 Switch

pcs4-6509-sw.txt

Site5 Cisco 3750 Switchl

pcsS5-3750- swl.txt

Site5 Cisco 6506 Switch

pcs5-6506-sw.txt

Site5 Cisco 7206 VXR Router

pcsS5-7206.txt

Site8 Cisco 3750 Switchl

pcs8-3750-sw.txt

Site8 Cisco 3750 Switch2

pcs8-3750-sw2.txt

Site8 Cisco 3825 Gatekeeperl

pcs8-3825-gkl.txt

Site8 Cisco 3825 Gateway1

pcs8-3825-gwl.txt

Site8 Cisco 3825 Gateway?2

pcs8-3825-gw2.txt

Site8 Cisco 3825 Gateway3

pcs8-3825-gw3.txt

Site8 Cisco 7206 VXR Router

pcs8-7206.txt

Site9 Cisco 3845 Gatekeeperl

pcs9-3845-gkl.txt

Site9 Cisco 7206 VXR Router

pcs9-7206.txt

Test Bed 3 Call Flows: Cisco Unified Customer Voice Portal
Post-Routed Call Flow Components

CC_UC701 _reference_configs_ CVP.zip (right-click to
download zip) includes the files below.

Note If you click the link rather than right-click, the zip
file may open in the secondary window but also
replace the contents of this window. Use your Back
button to return to this window.

Sitel Cisco 3745 Gatekeeperl

ps1-3745-gkl.txt

Sitel Cisco 3745 Gatekeeper2

ps1-3745-gk2.txt

Sitel Cisco 6509 Switchl

ps1-6509-swl.txt

Sitel Cisco 7206VXR Router

ps1-7206.txt
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Table 8-11 Configuration Command Files for Contact Center (continued)
Description Filename

Sitel Cisco Content Services Switchl psl-cssl.txt

Sitel Cisco Firewall Service Modulel psl-fwsml.txt

Site3 Cisco AS5400HPX Gateway?2 ps3-5400-gw2.txt
Site3 Cisco AS5400HPX Gateway3 ps3-5400-gw3.txt
Site3 Cisco 6506 Router ps3-6506-rtr.txt

Site3 Cisco 6506 Switchl ps3-6506-swl.txt
Site5 Cisco 6509 Router ps5-6509-rtr.txt

Site5 Cisco Content Services Switch2 psS-css2.txt

Site6 Cisco AS5400HPX Gateway?2 ps6-5400-gw2.txt
Site6 Cisco AS5400HPX Gateway3 ps6-5400-gw3.txt
Site6 Cisco AS5400HPX Gateway4 ps6-5400-gw4.txt
Site6 Cisco AS5400HPX Gateway5 ps6-5400-gw5.txt
Site6 Cisco PSTN/VXML Gateway?2 ps6-pstn-vxml-gw?2.txt
Site6 Cisco 3845 Cisco Unified Border Elementl ps6-3845-cubel .txt
Site8 Cisco PSTN Gateway1 (with Unified Presence) ps8-pstn-gw 1 -cup.txt
Site8 Cisco 3845 SIP VXML Gateway1 (with Unified ps8-3845-gwl-vxml-cup.txt
Presence)

System Demo

The Cisco Unified Communications system demonstration document is for Cisco sales teams and
describes the various methods available to demonstrate the Cisco Unified Communications System.

Cisco Unified Communications System Demo [INTERNAL]

System Compatibility Tool

The Cisco Unified Communications Compatibility Tool provides tables that identify the compatible
software release versions for each product element in each Cisco Unified Communications release.

Ordering Guides

Ordering guides &' for most Cisco Unified Communications products are available for Cisco partners,
Cisco sales staff, and Cisco service providers.
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End-of-Sale and End-of-Life Products

The end-of-sale (EOS) date is the last date to order the product through Cisco point-of-sale mechanisms.
The product is no longer for sale. There is also an end-of-life (EOL) process that guides the final business
operations associated with the product life cycle.

The EOL process consists of a series of technical and business milestones and activities that, once
completed, make a product obsolete. Once obsolete, the product is not sold, manufactured, improved,
repaired, maintained, or supported.

For information about recommended replacements, see the comprehensive list of announcements at the
following URL:

http://www.cisco.com/en/US/products/prod_end_of_life.html

For information on specific products, choose a product from the following URL.:
http://www.cisco.com/en/US/products/sw/voicesw/index.html

Then click on the End-of-Life and End-of-Sale Notices link in the Product Literature box.

For an overview of the Products and Services EOL policy, see the information at the following URL:

http://www.cisco.com/en/US/products/products_end-of-life_policy.html

Cisco Unified Workspace Licensing

Cisco Unified Workspace Licensing is an easy, affordable program for procurement of a broad range of
Cisco Unified Communications applications and services. Unified Workspace Licensing facilitates
consistent deployment of multiple applications to all users in their workspaces and helps organizations
maximize the potential of unified communications.

This program streamlines pricing, licensing, and deployment of Cisco Unified Communications
solutions and enables organizations to implement a media-rich unified communications experience at a
cost-effective user basis.

Documentation Wiki

The Cisco documentation wiki (DocWiki) contains information on a number of Cisco product-related
topics. Among these is a category for Cisco Unified Communications Systems, which currently includes
topics for:

¢ Unified Communications System Design: This topic includes information and tutorials on design
tools such as the Cisco Unified Communications Sizing Tool, which can be used to design and model
solutions for existing and prospective customers.

¢ Unified Communications System Implementation: This topic includes information on installing and
configuring system components, and provides detailed configuration examples based on tested
deployment models.

e Unified Communications System Operations: This topic includes information on the tasks you need
to perform to maintain and optimize your system and keep it operating as trouble-free as possible.
These tasks are broken down into two areas: one-time and infrequent tasks, and regular and
scheduled tasks.
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e Unified Communications System Troubleshooting: This topic includes information that will assist
you with isolating and resolving problems you may have with Unified Communications system
components. This topic offers sections for system troubleshooting methodology and commonly
encountered problems.

For additional Cisco Unified Communications topics posted on the Cisco documentation wiki, see
http://docwiki.cisco.com/wiki/Cisco_Unified_Communications.
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